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Getting Started

OVERVIEW

Welcome to the McGraw-Hill Multimedia Encyclopedia of Science & Technol-
ogy. This CD-ROM contains articles and illustrations from the McGraw-Hiil
Encyclopedia of Science & Technology, 8th Edition, and scientitfic terms from
the McGraw-Hill Dictionary of Scientific and Technical Terms, 5th Edition,

as well as additional material created especially for this CD-ROM. The infor-
mation stored on the CD-ROM is organized into the following content areas:

* Encyclopedia: 7,100+ articles.
» Dictionary: 122,000+ definitions for 105,000 scientific terms.

+ Biographies: biographical sketches of 250+ important people in the his-
tory of science and engineering.

» Study Guides: curriculum outlines with appropriate articles for student in-
struction in six disciplines: biology, chemistry, engineering, geosciences,
health sciences and physics.

The McGraw-Hill Multimedia Encyclopedia of Science & Technology also in-
cludes the following multimedia features.
» Animations; 78 animations bringing insight to difficult concepts.

+ Graphics: more than 2,100 color illustrations, photographs. charts, and
tables.

+ Maps: 30 maps with links to expanded almanac data.
» Sky Maps: 45 sky maps and constellation maps.
» Crystal Animations for most chemical elements.

SYSTEM REQUIREMENTS

+ IBM/PC compatible, 486 or later (Pentium preferred)
» 12 MB RAM minimum (16 MB recommended)

* 10 MB free hard-disk space

* Windows 95 or higher

* CD-ROM drive (8 X or faster recommended)

*  Windows compatible sound card and Windows compatible printer
(optional)
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INSTALLATION AND START-UP

1. Turn on your computer and start Windows.

2. TInsert the McGraw-Hill Multimedia Encyclopedia of Science & Technol-
ogy CD into your CD-ROM drive,

3. Click the Start button (on the task bar in the bottom left-hand corner of
the screen) and choose Run....

4. In the Open blank, type x:\setup (where “x:” represents the letter for your
CD-ROM drive).

5. Click OK or press Enter.

6. Follow the instructions that appear on your screen. At the end of the in-
stallation, the Choose Directory screen appears. This screen allows you o
change the default path for storing bookmarks and articles you want to
save from the Encyclopedia, It is also where you can specify the path to
your Web browser, for Web scarches (see “Searching the Web™).

7. After choosing paths, installation is complete. It is a good idea to read the
Readme file, which is accessible from the Setup Complete screen.

8. To start the MeGraw-Hill Multimedia Encyclopedia of Science & Tech-

nology program, click Start, point to Programs and McGraw-Hill 2.1,
then click MEST 2.1.

McGraw-Hill Multimedia Encyclopedia of Science & Technology « 3



Quick Tour

Once you have installed McGraw-Hill Multimedia Encyclopedia of Science &
Technology, you are ready to explore. Here’s a five-minute tour of the basic
features.

1. Start the MEST 2.1 program. (See step 8 in “Installation and Start-Up.”)

2. The main screen appears, showing the opening title graphic. After a few
seconds, the graphic will disappear.

3. Younow have two choices for exploring the McGraw-Hill Multimedia
Encyclopedia: browsing or searching. Let’s start by browsing the chem-
istry articles in the Encyclopedia.

a. An alphabetical list of article titles appears in a window on the left-
hand side of the screen. To view titles of Encyclopedia articles, click
the Encyclopedia button.

b. The list includes all articles in the full Encyclopedia. To browse just
chemistry articles, let’s use a iopic filter. Click the Set Filter button on
the program toolbar at the top of the screen. Then select Filter Ency-
clopedia by Topic, Chemistry, and All Chemistry Subtopics.

¢. Now the list includes chemistry articles only. You can either scroll to a
topic of interest or begin typing in the Find box. Type periodic to jump
to the Periodic table entry.

d. Double-click on the Periodic table entry to open the Periodic table
article.

4. The article tooibar at the top of the article window gives you easy access
to the features you’ll probably use most frequently. Let’s look for the
word “neon” in the Periodic table article.

a. Click on the Find a word icon on the article toolbar.

b. Type neon and either press Enter or click Find. The article jumps to
the first occurrence of the word “neon.”

(For information on the other icons, see “Viewing Articles.”)
5. Hypertext links are used throughout the Encyclopedia to provide an easy
way to get to related information.

a. Scroll down a few paragraphs from the occurrence of “neon.” You will
see two underlined links, both to 1llustrations.

.

b. Click on Fig. 3.

¢. A figure now appears in a separate illustration window. You can move, re-
size, or close the illustration window using standard windows controls.

6. Now, let’s do & search to find more information about neon.

a.

Click the Search button on the program toolbar at the top of the
screen,

In the Search form, click the Search CD button if it is not already
selected. (You can do a Web search later.)
Type neon in the first Search Term box.

Note that all subjects in the Subjects area are checked. To restrict the
search to chemistry and earth science articles only, click Clear All,
then select the Chemistry and Earth Science check boxes.

e. Click Search.

The Search Results window lists all Encyclopedia chemistry and earth
science articles in which “neon” occurs. Results are sorted by rele-
vance: the articles with the greatest number of “hits” (occwrrences of
the search term) appear at the top of the list. Double-click on Neon to
open the Neon article.

4 » McGraw-Hill Multimedia Encyclopedia of Science & Technology
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Navigating

Moving around within the McGraw-Hill Multimedia Encyclopedia of Science
& Techrnology 1s easy. The menu bar, which runs across the top of the screen,
gives you access to all of the program’s features. The program toolbar, which
appears directly below the menu bar, provides buttons for the most frequently
used features. If you rell the mouse pointer over any button, a brief explana-
tion of the function of that button will appear next to it.

PROGRAM TOOLBAR

MENUS

Menu ~ Command

Use fo...

Click this button to view the contents window, which
shows an alphabetical listing of the entries in the se-
lected content area. (There are four content areas: En-
cyclopedia, Biographies, Study Guides, and Dictionary.
To change the content area, click the appropriate button
at the top of the content window.)

Click this button to open the Search dialog box, For
more information, see “Doing Searches.”

Click this button to browse a subset of articles in the
Encyclopedia or Biographies content area. In the Ency-
clopedia, you can filter by topic or by multimedia fea-
ture. In Biographies, you can filter by topic. For more
information, see “Browsing Content Areas.”

Click this button to open the Search History dialog
box, from which you can refine and/or retrieve the re-
suits of previous searches. For more information, see
“Working with Search History.”

Click this button to create a bookmark to the current ar-
ticle for easy reference later. For more information, see
“Bookmarking Articles.”

Click this button to enlarge the text in the active win-
dow seo that it is easier to read.

Click this button to shrink the text in the active window
so that you can view more information at one time.

Click this button to close all open windows, for example,
to start looking for information for a different project.

File Save... (CHl+S)

Close (Ctrl+F4)

Print... (Ctrl+P)

Print Setup...

Preferences...

Exit (Alt+F4)

Edit  Copy Cul+C)

Paste (Ctrl+V)

Search View Contents
(F3)

Encyclopedia

Dictionary

Save a copy of the article (text and/or graphics) in the ac-
tive window to a separate file on your hard disk or af
drive. The file name is limited to 8 characters.

Close the active window. Before closing a specific window,
you must first elick on the window to be sure it is active.

Print a copy of the article that's in the active window. You
can print the article text and/or graphics.

Specify setings for printing text or graphics from the
McGraw-Hill Multimedia Encyclopedia. For more infor-
mation on using printers, refer to your Windows manual
or view help in the Control Panel in Windows.

View or change locations for saved files and bookmarks,
the location of your Web browser, or audio and video op-
tions. For more information, see “Changing Preferences.”

Quit from the McGraw-Hill Multimedia Encyciopedia of
Science & Technology program.

Copy selected text or graphics from the McGraw-Hill Muti-
media Encyclopedlia of Science & Technology to the Win-
dows clipboard. In conjunction with the Paste command,
you can use Copy to create a duplicate of material in the
MeGraw-Hill Multimedia Encyclopedia. Before using the
Copy command, you must first select text or graphics to copy
by highlighting the appropriate material in the article window.

Paste the contents of the Windows clipboard at the cursor
positian. Since the McGraw-Hill Multimedia Encyclopedia
of Science & Technology is on a CD-ROM, you cannct paste
information into an arficle window. However, you can copy
a complicated term from an article window and paste it into
the Search dialog to do a search on that term.

Open the contents window to browse one of the four
content areas on the CD. For more information, see
“Browsing Content Areas.”

Browse the Encyclopedia in the contents window. When
the Encyclopedia is selected, this option is checked on the
Search menu. (This option is available only when the con-
tents window is the active window.)

Browse the Dicticnary in the contents window. When the
Dictionary is selected, this opticn is checked on the Search
menu. (This option is available only when the contents win-
dow is the active window.)

6 * McGraw-Hill Multimedia Encyclopedia of Science & Technology
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- Menit .

T

Use fo...

Bookmark

View

Document

Biographies

Study Guide

Filter (F2)

Search... (F4)

Search History... {F7)

Clear Search History

Create... (F8)

List (F9)

Enfarge
Reduce
Original Size

Find... (Ctrl+F}

Find Again (Ctrl+G)

Next Term
(Cul+N)

Previous Term
{CHl+T)

Browse Biographies in the contents window. When
Biographies is selected, this option is checked on
the Search menu. (This option is available only
when the contents window is the active window.)

Browse the Study Guide in the contents window.
When the Study Guide is selected, this option is
checked on the Search menu. (This option is available
only when the contents window is the active window.)

Browse a subset of the Encyclopedia or Biogra-
phies. You can filter the Encyclopedia by topic or
by feature (animations, maps, skymaps, or illustra-
tions}, and you can filter Biographies by topic.

Open the Search dialog box and set up a search.
For more information, see *Doing Searches.”

Open the Search History dialog box to refine previous
searches or retrieve previous search results. For more
information, see "Working with Search History.”

Delete ail searches from the Search History dialog box.

Create a new bookmark in the current article. Once
created, you can use hookmarks to jump to frequently
used articles. When vou create a bookmark, the
MeGraw-Hill Multimedia Encyclopedia of Science &
Technology will automatically give it a fentative name
which matches the article name. You can change the
name or keep the article name as the bookmark name.
for more information, see “Bookmarking Articles.”

Open the Bookmark List dialog box, from which you
can go to any bookmarked article.

Increase the size of the text in the active window.
Decrease the size of the text in the active window.
Change the text in the active window to the defaul: size.

Open the Find dialog box so that you can jumpto a
particular word or phrase within the current article.

Repeat the most recent Find command another time,

Cio to the next occurrence of a search term in the
current article. This command is active only after
performing a search.

Goto the previous accurrence of a search term in
the current article. This cemmand is active only
after performing a search.

8§ * McGraw-Hill Multimedia Encyclopedia of Science & Technology
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Menu | Command. ‘Use'ta...
View Related View a list of other articles related to the article in the
Article (Cirl+R)  active window. (Related articles are articles that have
cross references to the current article.) In the Related
Articles window, scroll through the list and double-click
an the name of the article you want to view.
View Outline View a hierarchical outline associated with the
(Ctrl+0) current Encyclopedia article,
View llustration  View illustrations or graphics associated with the
(Ctrl+D) current Encyclopedia article.
View Pholo View photographs associated with the current
(Ctrl+H) Encyclopedia article.
View Map View topographic maps associated with the current
(Ctrl+M) Encyclopedia article.
View Skymap  View sky maps associated with the current
(Ctrl+K) Encyclopedia article.
View Animation  View animations associated with the current Encyclopedia
(Ctrl+A) article. Unlike other multimedia elements in the Encyclope-
dia, animation windows are fixed in size since the quality of
the animations will be affected by resizing the window.
Window Cascade Stack all open windows, one window on top of another. When
(Shft+F5) the McGraw-Hill Multimedia Fncyclopedia of Science &
Technology is in use, Cascade is the default setting for article
windows.
Tile (Shft+F4) Arrange all open windows on screen so they do not overlap.
Arrange |cons Arrange minimized windows (icons) in a neat row at the
bottom of the screen. When you minimize a window from
the McGraw-Hilt Multimedia Encyclopedia of Science &
Technology, it is reduced to an icon, which you can move
anywhere on screen. Use this command to amange the icons
across the botlom of the screen.
Close Al Close all the open articles and windows. This command is
helpful when exiting the program or preparing the McGraw-
Hill Multimedia Encyclopedia of Science & Technology for
use by another person.
Open windows  Alist of open windows appears at the bottom of the Windaws
list meniz, To make a particular window active, click on its
name in this list.
Help Contents (F1) View the contents of the online help system.
Search... Search for a particular topic in the online help system.
Abott... View copyright and version information for the McGraw-Hilf
Multimedia Encyclopedia of Science & Technology.
License View the license agreement for the McGraw-Hill Multi-
agreement... media Encyclopedia of Science & Technology.

McGraw-Hill Multimedia Encyclopedia of Science & Technology » 9




Browsing Content Areas

There are four discrete content areas on the CD. When you browse a content
area, you work with an alphabetical listing of entries in that area. To browse:

1. Open the contents window (see the figure below) by clicking the Contents
bution on the program toolbar or selecting View Contents on the Search
menu. (If you already have a conients window open, you can make it ac-
tive by selecting it from the list of open windows on the Window menu.)

2. Select a content area by clicking on one of the content area buttons at the
top of the contents window. By default, Encyclopedia is selected.

3. Move to an entry of interest. You can use the scroll bar, browse the list, or be-
gin typing a word in the Find box to jump to the nearest location in the list.

4. 'To view an entry, double-click on its name in the list. An article window
appears to the right of the contents window (unless the contents window
is maximized, in which case the article window appears at full-screen size
on top of the contents window).

I:ch;l;yp;;jua :'T

A

Use these controls to minimize,
maximize, or close the contents window

A

Click one of these buttons to select a
content area

. Start typing a word here to jump to its
: Climate histo location in the list

i Climate modeling

i Climate modification
i Climatic prediction

Il Climatology

i Clinical immunology
i| Clinical microbiology
i{ Clinical pathology

4 Qipping circuit

{ Clock

Double-click on the selected entry to
open its article or entry

i Clock paradox
A Closed-caption television
{| Closed-circuit television
4 Clostridium

Scroll through the list using the scroll bar

4 Cloud ~
4 Cloud physics

Alphabetical listing of entries in the
content area

10 * McGraw-Hill Multimedia Encyclopedia of Science & Technology

You can have more than one contents window open at a time, if you wish. To
open a new contents window, click the Contents button on the program tool-
bar. The new contents window will appear on top of the previous one. Click
and drag the new contents window to the right if you want to view both win-
dows at the same time. To work with a contenis window that is already open
but not active, select that window from the list at the bottom of the Window
menu on the menu bar at the top of the screen.

You can also have more than one article window open at a time. When you
open a new article window, it appears on top of the previcus one. Open article
windows are stacked so that you can see their title bars. To switch to a differ-
ent article window, click on its title bar. To cycle through all open article win-
dows, most recent first, use Ctrl+Tab.

By default, the contents window appears on the left side of the screen, leaving
room for article windows to appear on the right side of the screen. Use the
window control buttons in the upper right-hand corner of the contents and ar-
ticle windows to minimize, maximize, or resize them as you prefer. Also note
that you may have as many as 10 windows open at any time. When you reach
the limit, you will need to close some open windows before you can proceed.

USING FILTERS TO BROWSE THE ENCYCLOPEDIA

Because the Encyclopedia is so large, you may want to browse just a subset

of articles. You can do so by using one of the browse filters, as follows:

1. Open the contents window and click the Encyclopedia butten, if not al-
ready selected.

Click the Set Filter button on the program toolbar.

3. Select an option on the Filter drop-down menn:

» Choose Filter Encyclopedia by Topic to browse articies in a particular
topic area. Then choose a topic from the pop-up list. If the topic is fur-
ther broken down into subtopics, choose a subtopic.

» Choose Filter Encyclopedia by Feature to browse articles that have a
particular multimedia feature associated with them. Then choose a fea-
ture from the pop-up list.

4. Now the list in the Encyclopedia contents window is filtered. The list in-
cludes only those entries that are in the topic area you selected or with the
feature you selected.

Note that you can repeat this procedure to open more than one filtered list
(for example, a list of articles related to cell biology and another list of arii-
cles related to microbiology). For each list, however, only one topic filter can
be applied.

McGraw-Hill Multimedia Encyclopedia of Science & Technology * 11



Doing Searches

Searching is the most powerful feature of the McGraw-Iill Multimedia Ency-

clopedia of Science & Technology. You can search the Encyclopedia on the
CD, or you can search the World Wide Web. In fact, you can perform a com-
plex search on the CD, then go online and do the same search on the Web.
Your searches can be as simple as entering a single keyword or as sophisti-

cated as using multiple search criteria with Boolean and proximity operators.

To open the Search dialog box, click the Search button on the program tool-
bat or select Search... from the Search menu.

SEARCHING THE CD

To search the Encyclopedia on the CD:

1. If Search CD is not selected, click on its butten to select it

2. Inthe first Search Ferm box, type the word or phrase you want to find.

3. To search for muitiple terms, use the other Search Term boxes (enter
your terms here) and the operator boxes (specify how you want your
terms to be connected here).

Specily logical cperators  Enter your search Specify the proximity
between your terms terms in these boxes  of your search terms

Specify where you

want your term({s) found

Click to start your
search

tenis of the clipboard
at the cursor position

Click to paste the con-

and settings

Click to clear all terms

Click to access online

help
Check the sub-  Specify how Specify which Web Click to close the
ject areas you you want your  search engine you Search dialog box

want 1o look in results ranked want to use (Web
searches only)

12 » McGraw-Hill Multimedia Encyclopedia of Science & Technology

» The AND operator searches for articles that contain all your search terms.
For example, ORGANIC AND cHEMISTRY finds all articles that contain both
the terms ORGANIC and CHEMISTRY. It would not find an article that con-
tains the term CHEMISTRY without the term ORGANIC.

» The OR operator searches for entries that contain any one of your search
terms. For example, ORGANIC OR CHEMISTRY finds all articles that contain
the term ORGANIC, the termn CHEMISTRY, or both terms.

+ The NOT operator searches for resnlts that do not contain your search
term. For example, cHEMISTRY NOT ORGANIC finds all articles that con-
tain the term CHEMISTRY but not ORGANIC.

If you entered more than one search term, use the Word Relationship area to

specify how close to each other the terms should be. By default, the program

will look for your terms anywhere in the article.

+ To find all the terms in a single paragraph, check the Within Paragraph box.

+ To find all terms within a specific number of words of each other, check
the Word Apart box and type a number to specify the maximum number
of words apart you want your search terms to be.

In the Search In area, specify the location where you want your search

term(s) found. By specifying a Search In location, you can broaden or nar-

row your search.

»  Click Full Text (the default) to search the full text of the Encyclopedia.

» Click Article Titles Only to search article titles only.

Use the Subjects area to limit a search to any one or more of the 10 subject

areas. When a subject is included in a search, the box preceding the subject

name is marked with a check. By default, all subjects are included (that is,
there is a check in every subject check box).

+ To exclude a checked subject (that is, remove the check), click on that
subject’s check box.

+ To include a subject not checked (that is, add the check), click on that
subject’s check box.

» To exchude all subjects (remove all checks), click Clear All, Note that
you need to select at least one subject before you start your search.

Use the Sort Results area to set the order for your search results.

« Click Alphabetically to sort search results alphabetically by title.

+ Click By Relevance (the default) to sort search results from most rele-
vant to least relevant, according to the number of occurrences of the
search term(s) in the article.

Click the Search button to perform your search.

The search results window lists the entries resulting from your search: to

view an article listed, double-click on its title in the search results list. See

“Viewing Articles” for more information.

McGraw-Hill Maltimedia Encyclopedia of Science & Technology » 13



SEARCHING THE WEB

The McGraw-Hill Multimedia Encyclopedia of Science & Technology pro-
vides a seamless way to search the vast resources on the World Wide Web for
a topic of interest. You set up ycur search in the Search dialog box. Then,
when you click the Search button, the McGraw-Hill Multimedia Encyclope-
dia of Science & Technology program auntomatically converts your search into
a query that the Web search engine understands, launches your Web browser,
and does the search. To do a Web search:

1. Make sure that the Web browser specified in your Preferences is correct:
a. Select Preferences... on the File menu.

b. Check the path listed for your Web browser .exe. If it’s not correct,
click Browse and specify the correct location of your browser.

¢. Click OK to register any changes and close the Preferences dialog box.

2. Establish a connection with the Internet if your system does not automati-
cally establish a connection when your browser is launched.

3. To open the Search dialog box, click the Search button on the program
toolbar.

Click the Search Web button.

Set up your search terms (see steps 2 through 4 in “Searching the CD”).
In the Search the WWW area, specify which search engine you want to use.
Click the Search button to perform your search.

o Nk

Your Web browser is launched, the search is executed, and your search re-
sults appear in your browser window. At this point, you are in an online ses-
sion and can move around within your browser or return to the MeGraw-Hill
Mulfimedia Encyclopedia of Science & Techrology program at any time.

WORKING WITH SEARCH HISTORY

The Search History dialog box lists all of the searches you have performed in
your current session. You can use your search history to retrieve the resulis
from previous searches or to refine searches.

To access the Search History dialog box, click the History button on the program
toolbar at the top of the screen or select Search History.. on the Search menu.

For each search performed, the search history list shows the search pattern
(terms and operators used to connect them), the number of articles resulting
from the search, and the total number of occurrences of your search term
(“hits™). To work with a particular search, highlight it in this list and then
click the appropriate button to the right of the list.

14 » McGraw-Hill Multimedia Encyclopedia of Science & Technology

This is the list of searches you have  Click to show the results
done in the current session for the selected search
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Click to open the Click to delete the  Click to delete all Click to close this
Search dialog box selected search of the searches in dialog box

with the selected your search history

search

Viewing Articles

Once you have found an article of interest, double-click on its name to open
it. From the article window, you can then print the article, copy portions of it
to the Windows clipboard, bockmark the article for quick reference laier,
view associated multimedia features (where available), look for a particular
word or phrase within the article, or look up a word in the Dictionary.

The text of an article appears in the article window. Note the following:

= If the article resulted from a search, your search terms are highlighted in
the text of the article.
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« Cross references to other articles are presented as hypertext links, appearing
as underlined text: click on a link to jump to the cross-referenced article.

= Double-clicking on any word in the article will bring up the closest entry
in the Dictionary.

= You can change the size of the text in the article by clicking the Enlarge
or Reduce button on the program toolbar at the top of the screen.

+ Use the Document menu or the article toolbar (see below) to access asso-
ciated elements, jump to a particular word or phrase in the text, or jump to
the next occurrence of your search term.

= Close the article window by selecting Close from the File menu.

ARTICLETOOLBAR

The article toolbar appears at the top of every article window and includes but-
tons for viewing elements associated with the article, jumping to other occur-
rences of a search term, and finding a particular word or phrase within the article.

These are the buttons on the article toolbar:

Previous Term button
Use this bution to go to the previous occurrence of a search term in
the current article. This button is active only after performing a search.

Next Term button
Use this button to go to the next occurrence of a search term in the
current article. This button is active only after performing a search.

Find button
Use this button to jump to a particular word or phrase in the active
article only.

Find Again button
After using the Find button, use this button to jump to the next occur-
rence of the same word or phrase in the active article.

Related Articles button

Use this button to view a list of other articles related to the current
article. Related articles are articles that have cross references to the
current ariicle.

Outline button
Use this button to view the hierarchical outline for the active
article.

Illustration button
Use this button to view illustrations associated with the active article.
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Photo button
Use this button to view photographs associated with the active article.

Map button
Use this button to view maps associated with the active article.

Skymap button
Use this button to view skymaps associated with the active article.

Animation button
Use this button to view an animation associated with the active article.

Close button
W Use this button to close the active article window.

Remember, you can always get a brief explanation of the function of a button
by rolling the mouse pointer over it.

BOOKMARKING ARTICLES

Boekmarks are electronic paper clips that mark articles for quick reference.
The McGraw-Hill Multimedia Encyclopedia of Science & Technology can
store any number of bookmarks (depending only on available space in the
location designated for saving bookmarks).

Adding a bookmark
1. Position the cursor anywhere in the article you want to mark.
2. Select Create... from the Bookmark Menu or press F8.

3. When the Bookmark dialog box appears, type a new narne for the book-
mark if you do not want to use the default name (which is the article title).

4. Click Create Bookmark or press Enter to add the new bookmark to your
bookmark Hist.

Going fo a specific bookmark

1. Select List from the Bookmark Menu.

2. Scroll to the desired bookmark in the Bookmark List dialog box.
3. Dounble-click on the bookmark name.

Deleting a bookmark

1. Select List from the Bookmark Menu.

2. In the Bookmark List dialog box, screll to the bookmark you want to delete.
3. Click Delete.
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Changing Preferences

Preferences are settings that control certain functions and specify various file
locations for work done in the McGraw-Hill Multimedia Encyclopedia of Sci-
ence & Technology. These preferences are set up during program installation.
However, you can change them at any iime. To view and/or change your pref-
erence seftings:

1. Select Preferences... on the File menu.
2. In the Preferences dialog box, you can change any of these settings:

» The Audio ON box should be checked if you want to be able to hear
the audio elements in the McGraw-Hill Multimedia Encyclopedia. If
yon do not have an audio driver or sound card included in your com-
puter, it is suggested that you turn off the audio elements by leaving
this check box empty.

» The Video ON box should be checked if you want to be able to view
the animations included in the McGrew-Hill Multimedia Encyclopedia.
If you have a limited amount of computer memory, you can improve
the performance of the program by turning this setting off (removing the
check from the check box).

» The Change default Save path setting shows you the defauli location
for storing articles that you save from the McGraw-Hill Multimedia
Encyclopedia. To change the Save default location: click the Browse
button, select the drive and directory that you want to be the new de-
fault location, and click OK.

e The Change default Bookmark path setting shows you where book-
marks from the McGraw-Hill Multimedia Encyclopedia of Science &
Technology are saved. To change the bookmark location: click the
Browse button, select the drive and directory that you want to be the
new bookmark file location, and click OK.

» The Change Web browser .exe path setting shows you where
MeGraw-Hill Multimedia Encyclopedia of Science & Technology
leoks to launch your Web browser for doing Internet-based searches.
To specify a different location for your Web browser: click the Browse
button, select the drive and directory path to your Web browser, and
click OK. Note: to disable the Web browser function, you must rein-
stall the program.

3. Click OK to register any changes and close the Preferences dialog box.
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